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Le	 logiciel	 de	 statistiques	 pour	 le	 Baseball	 et	 le	 Softball	 nommé	 ‘The	 Automated	 Scorebook’	
(TAS),	conçu	par	la	société	américaine	de	logiciels	de	sports,	Stat	Crew	Software	Inc,	est	devenu	le	programme	
officiel	 de	 la	 CEB	 (Confédération	 Européenne	 de	 Baseball)	 lors	 des	 compétitions	 majeures	 en	 2007,	 après	
l'impulsion	de	la	CEB	et	l'expérience	de	la	FIBS	(Fédération	Italienne	de	Baseball	et	Softball)	en	2006,	Anna	Maria	
Paini	 ayant	 été	 la	 pionnière	 dans	 les	 ligues	 italiennes.	 En	 2008,	 la	 CEB	 ainsi	 que	 plusieurs	 Fédérations	
Nationales	ont	lancé	des	programmes	de	perfectionnement	et	ont	étendu	son	usage	dans	la	plupart	des	
tournois	 et	 championnats.	 L'IBAF	 a	 également	 commencé	 à	 utiliser	 ce	 logiciel	 en	 2008,	 il	 est	
actuellement	utilisé,	en	général,	dans	toutes	les	compétitions.		

	
Ce	guide	a	pour	but	d'aider	dans	cette	tâche,	afin	que	de	nombreux	scoreurs	européens	puissent	

facilement	apprendre	à	l'utiliser	dans	les	compétitions	internationales,	nationales	ou	locales.		
	

Vous	 trouverez	 dans	 ce	 guide	 "seulement"	 les	 informations	 nécessaires	 pour	 scorer	 une	
rencontre	:	comme	vous	pouvez	l'imaginer,	le	logiciel	a	de	nombreuses	fonctions,	possibilités,	menus...,	
beaucoup	d'entre	eux	étant	gérés	par	l'opérateur	central	(OC).	Vous	en	découvrirez	peut-être	au	fur	et	à	
mesure	de	vos	utilisations,	mais	nous	ne	considérons	pas	nécessaire	de	les	détailler	ici.	

	
Ce	logiciel	permet	de	scorer	la	rencontre	en	direct,	ce	qui	permet	de	mettre	en	ligne	sur	le	site	

Internet	 du	 tournoi	 toutes	 les	 actions,	 les	 statistiques,	 les	 résultats	 et	 le	 ‘play	 by	 play’	 résumant	 la	
rencontre.	Il	peut	bien	sûr	être	utilisé	après	la	rencontre	pour	insérer	des	données	dans	une	rencontre	
déjà	jouée.		

	
Le	programme	comporte	2	parties	:	une	pour	scorer	la	rencontre	(‘The	Automated	Scorebook’),	

et	une	autre	(appelée	‘TAS	FTP’)	pour	mettre	la	rencontre	en	ligne.	À	la	fin	de	chaque	rencontre,	il	faut	
utiliser	un	"client	FTP"	afin	de	mettre	 la	box	score	en	 ligne	(dans	ce	manuel,	nous	utilisons	 ‘Leech	Ftp’,	
mais	tout	type	de	client	FTP-comme	FileZilla-	peut	être	utilisé	pour	cela	

	
Nous	 sommes	 certains	 qu'en	 utilisant	 ce	 manuel	 et	 avec	 un	 peu	 de	 pratique,	 vous	 pourrez	

facilement	apprendre	à	utiliser	parfaitement	le	logiciel.	
	

Pour	toute	question	ou	commentaire,	merci	de	contacter	scorer@baseballeurope.com.	
	 	

COURTE	INTRODUCTION	AU	LOGICIEL	'THE	AUTOMATED	SCOREBOOK'	



The	Automated	ScoreBook	–	Opérateur	de	Saisie	
Entry	

	

	
5	

	

Termes	et	symboles	utilisés	dans	le	manuel	

 

>	 Indique	une	action	à	faire.	

☺	 Tips,	recommandations	pour	une	utilisation	plus	facile.	

G 	 Attention:	actions	qu'il	faut	réaliser	exactement	comme	indiqué.	

!		 Actions	à	NE	PAS	faire	/	Dangereuses	pour	le	programme	/	la	rencontre.	

F 	 Voir	page	...	

	
OPERATEUR	DE	SAISIE	(OS)	(Aussi	appelé	Operateur	Local	ou	Data	Entry)	:	
Il/elle	est	le	scoreur	qui	gère	le	programme	pendant	la	rencontre.		
Bien	sûr,	il/elle	doit	rentrer	exactement	les	mêmes	données	que	le	scoreur	officiel,	qui	appellera	clairement	
les	jeux	(même	les	jeux	simples,	pour	éviter	les	erreurs).		
	
L'OS	 doit	 vérifier	 les	 statistiques	 générées	 par	 le	 programme	 avec	 celles	 du	 scoreur	 official	 à	 la	 fin	 de	 la	
rencontre.		
	
OPERATEUR	CENTRAL	(OC)	:		
Il/elle	est	la	personne,	désignée	par	l'organisation	(CEB),	responsable	de	la	gestion	de	la	compétition:	reçoit	et	
envoie	les	informations	aux	DE,	vérifie	les	données,	alimente	le	site	web,	élabore	les	statistiques	et	le	bulletin	
…	
L'Opérateur	Central,	avant	de	recevoir	et	d'envoyer	les	informations,	devra	décider	quel	programme	FTP	sera	
utilisé.	
	
WEBMASTER	:		
Il/elle	est	la	personne,	désignée	par	l'organisation	(CEB),		qui	conçoit	le	site	web	de	la	compétition	–	selon	les	
besoins	 du	 programme	 TAS	 –	 qui	 comportera	 le	 planning,	 les	 résultats,	 le	 classement,	 les	 statistiques	
cumulées	des	joueurs	et	des	équipes	…	
	
SCCP	 (CONTROL	 PANEL)	 Stats	 Crew	 Control	 Panel	 :	 C’est	 la	 fenêtre	 principale	 qui	 comporte	 les	 fonctions	
générales	du	programme.	
☺	Créer	un	raccourci	sur	le	bureau:	

☺	Pendant	la	rencontre,	ne	pas	fermer	cette	fenêtre:	la	réduire.	
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Lorsque	vous	entrez	dans	Game	Scoring,	appuyez	sur	la	touche		B,	puis	deux	fois	sur	ENTER	pour	arriver	dans		
	
Main	Menu:		Il	s'agit	du	menu	général	pour	gérer	la	rencontre:	insertion	des	informations	générales,	saisie	ou	
impression	 des	 lineups,	 sélection	 de	 la	 rencontre	 à	 charger,	 modification	 ou	 impression,	 etc.	 L'exemple	
montre	 la	 façon	 dont	 le	 programme	 affiche	 les	 jeux	 pendant	 la	 rencontre,	 cela	 ressemble	 à	 une	 feuille	 de	
scorage.	
	

	

☺	Comme	il	s’agit	d‘un	système	DOS,	on	peut	seulement	utiliser	 les	 flèches	directionnelles	ou	 la	 	première	
lettre	de	chaque	sous	menu	pour	les	choisir.	Aller	dans	scoresheet	et	appuyer	sur	ENTER	pour	arriver	dans	le		 
	
Scoresheet	Menu	:	Il	s'agit	du	menu	de	base	pour	débuter	le	scorage	de	la	rencontre	une	fois	les	données	sur	
cette	 rencontre	 saisies	 (lieu,	 date,	 arbitres,	 équipes,	 lineups	 …)	 et	 il	 contient	 toutes	 les	 instructions	 pour	
réaliser	le	scorage	de	la	rencontre.		
	

	
	
RACCOURCIS	CLAVIER	 :	 consulter	 le	document	 joint	à	 la	 fin	de	ce	manuel	pour	connaître	 les	 raccourcis	qui	

vous	seront	utiles.		

 
LEECH	FTP	:	C'est	un	"client	ftp"	pour	mettre	en	ligne	les	box	score.	 	
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�	Créer	un	raccourci	sur	le	bureau:	
	
Skype	 :	 Il	 s'agit	 du	 programme	 utilisé	 pour	 la	 communication	 en	 direct	 entre	 l'OC	 et	 les	 OS,	 	 l'envoi	 des	
fichiers,	des	messages	de	confirmation,	des	questions,	des	doutes.	

	

☺Créer	un	raccourci	sur	le	bureau	:	
	

	
☺ Rester en ligne pendant toute la rencontre. Peut-être n'avez-vous pas besoin de 
l'opérateur Central (OC), mais il peut aussi avoir besoin de vous contacter.  	
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Mise	à	jour	des	données	de	la	compétition	
	

Avant	le	début	de	toute	compétition,	l'OC	enverra	par	courriel	un	fichier	contenant	toutes	les	données:	
Equipes	et	Rosters.		
	

>	L'OC	crée	un	dossier	avec	l'année	et	le	nom	de	la	compétition	par	exemple		/CEB/2010/EURO.	
Une	fois	la	compétition	commencée,	l'OC	enverra	quotidiennement	un	dossier	mis	à	jour	(avec	les	mis	à	

jour	des	rosters,	des	données	des	rencontres,	des	statistiques	...).		
	

>	L'OS	effacera	le	dossier	précédent,	copiera	le	nouveau	et	l'ajoutera	sur	le	disque	C	de	l'ordinateur.			
Demander	de	l'aide	à	l'OC	si	besoin.		
	

Lorsque	vous	travaillez	sur	une	compétition	multi	site,	il	faut	télécharger	le	dossier	vous-même.	
Voici	comment	:			

	
>	Ouvrir	le	logiciel	‘Leech	FTP’	en	double	cliquant	sur	l'icône	de	votre	bureau	
>	Entrer	sur	le	server	du	site	Internet	en	cliquant	sur	l'icône	‘livre’		

	
	

>	Double	cliquer	sur	l'icône	du	serveur	dans	la	partie	droite	de	la	fenêtre		
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	 De	temps	à	autres,	 les	 identifiants	du	serveur	seront	changés.	Quand	cela	arrive,	en	double-cliquant	
sur	le	signet	(bootmark),	le	message	suivant	apparaît	:	“Could	not	login	to	competition.baseballeurope.com”.	
Dans	ce	cas,	il	faut	modifier	le	signet.	
	

Fermer	 la	connexion	en	cliquant	sur	 la	croix	blanche	sur	 le	bouton	rouge	 (à	côté	de	 l'icône	 livre).	
Cliquer	sur	l'icône	livre,	la	fenêtre	reproduite	sur	la	page	précédente	apparaît.		
	
>	Cliquer	sur	Edit	>	Choisir	‘Edit	bookmark’	
Demander	à	l'OC	les	données	et	identifiant	corrects	et	modifier	les	informations	dans	la	fenêtre		
Fermer	la	fenêtre	avec	OK.	A	présent,	vous	pouvez	double-cliquer	sur	l'icône	du	serveur	pour	continuer.		
	
Une	fois	connecté,	3	fenêtres	apparaissent	:		

- une	à	gauche.	
		Choisir	l'onglet	‘Threads’	et	la	progression	des	téléchargements	apparaît		
- au	centre:	se	trouve	la	liste	des	dossiers	de	votre	propre	ordinateur		
- à	droite:	se	trouve	la	liste	des	dossiers	présents	sur	le	serveur		

Pour	retourner	au	dossier	à	la	racine,	double-cliquer	sur	l'icône	dossier	avec	une	flèche	bleue		
>	 Demander	 à	 l'OC	 quel	 dossier	 est	 à	 télécharger	 du	 serveur	 (fenêtre	 de	 droite)	 vers	 votre	
ordinateur	(fenêtre	centrale).			
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>	Faire	un	“Glisser	déposer”	de	la	droite	vers	la	fenêtre	au	centre.	
	

L'OS	 doit	 seulement	 ouvrir	 et	 utiliser	 le	 dossier	 “GAMES”.	 NE	 PAS	 OUVRIR	 les	 autres	
fichiers	et	NE	JAMAIS	MODIFIER	QUOI	QUE	CE	SOIT	DANS	LES	AUTRES	DOSSIERS	pour	éviter	tout	
risque	d'effacer	d'autres	fichiers	importants	du	disque	dur	ou	du	serveur.			
	
Pour	sortir	du	logiciel	Leech	FTP		

	

G Ne pas fermer avec la croix X du coin droit de la fenêtre.  	
	
>	D'abord(1),	cliquer	sur	l'icône	‘prise’	(pour	se	déconnecter	du	serveur)	
>	Ensuite	(2)	cliquer	sur	l'icône	‘personnage’	(pour	quitter	le	logiciel)	

	
>	Ouvrir	le	programme:	
Double	cliquer		sur	l'icône	Control	Panel:	

	
	
	

OUVRIR	LA	BONNE	DIRECTORY	
	
>	Aller	dans	SCCP	>	Utilities/roster	maintenance	>	File	>	Open	directory	
>	 Choisir	 le	 bon	 dossier	 (chercher	 la	 bonne	 année)	 et	 ouvrir	 la	 bonne	 directory	 en	 double-cliquant	
dessus.		
	

Une	fois	la	bonne	directory	choisie	et	si	vous	ne	la	changez	pas,	le	logiciel	l'ouvrira	immédiatement	
sans	avoir	besoin	de	changer	la	directory	les	fois	suivantes.			

	
	
	
	 	

	
	

1	 2	
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Scorage	des	rencontres	en	direct	
	

Lors	des		tournois	CEB,	les	rencontres	doivent	toujours	être	scorées	en	direct	sur	Internet	en	utilisant	
le	play-by-play.	

		
>	Une	fois	arrivé	sur	le	terrain,	vérifier	la	connexion	Internet	du	lieu.		
>	Se	Connecter	à	Skype	pour	établir	la	communication	avec	l'OC.	
	
A	présent,	il	faut	s'assurer	d'afficher	les	stats	individuelles	en	ligne.		

	
>	Cliquer	sur	Control	Panel	SCCP	->	Utilities/roster	maintenance	

	
	
	
	
	
	
	
	
	
	
	

>	Cliquer	sur	StatEdit	files					>	cliquer	sur	Capture	stat	files	
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La	liste	des	équipes	apparait	:	
	

	

>	Cliquer	sur	Select	all	
>	Appuyer	sur	OK	
	
	Cette	fenêtre	apparait:	

	

>	Cliquer	sur	YES	et	OK	pour	toutes	le	équipes,	jusqu'à	la	fin.	Fermer	la	fenêtre	avec	EXIT.	
	
Ensuite	retourner	au	Control	Panel	et	ouvrir	‘Game	scoring’	pour	aller	dans	Game	Scorebook	
	

	

>	Cliquer	sur	Game	scoring		
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>	Taper	"B"	et	appuyer	deux	fois	sur	la	touche	ENTER	
(Le	programme	vous	propose	deux	types	d'informations	dont	nous	n'avons	pas	besoin	pour	l'instant).		
	
Ensuite	>	Sélectionner	Game	setup	et	après	sélectionner	Game	info	
	

	

	
	
	
	
	
	
	
	
	
	
	
	
Cette	fenêtre	apparait:	

	
>	Remplir	les	données	de	la	rencontre		
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G	Ecrire	les	mots	exactement	comme	donnés	dans	l'exemple	pour	assurer	l'uniformité	de	tous	les	documents	
et	fichiers.	
	
☺	Taper	ENTER	pour	accepter	l'option	proposée	par	le	programme.			
	
☺	Utiliser	les	flèches	du	clavier	(↑↓)	pour	se	déplacer	dans	la	fenêtre	et	si	vous	avez	besoin	de	corriger	
certaines	informations.	
	
☺	Si	vous	commettez	plusieurs	erreurs	dans	cette	fenêtre	vous	pouvez	utiliser	la	touche	ESC.	Recommencer	
l'opération	(Game	setup	>	Game	info)	pour	réécrire	les	données.		
	
Place	 (Ville)	:	ex.	Barcelona	(Première	lettre	en	majuscule,	le	reste	en	minuscules).		

Stadium	 (Stade):	ex.	Montjuic	(même	chose).	

Date	 Accepter	la	date	insérée	automatiquement	par	l'ordinateur	(Cliquer	sur	ENTER)	

	#	of	Batters:	9		 Ne	rien	modifier	

Ranking	#:		 Ne	rien	modifier	 (L'OC	complètera	cette	donnée	à	la	fin	de	la	rencontre)	

#	Sched	innings:		 Ne	rien	modifier			 	 (si	besoin,	l'OC	fera	la	modification)	

		 penser	aux	rencontres	en	7	manches	au	softball	et	en	U15.		

DH	Rule:				 Ne	rien	modifier			L'OC	indique	Y	(for	Yes)	ou	N	(for	No)		

Neutral	site:	 Ne	rien	modifier	 	

Nite	game:		 Choisir	N	(NO	=	pour	match	en	journée)	ou	Y	(Yes	=	pour	match	en	soirée)	

League	game:		 Choisir	Y	(=	rencontre	"normale"	du	tournoi)		

Sched	note:		 Ne	rien	écrire		

Game	Series	ID:	 Ne	rien	écrire	 	 	 (L'OC	pourra	modifier	cette	donné	après	la	rencontre)	
DH	Game#	 Signifie	programme	double,	non	utilisé	en	tournoi,	donc	ne	rien	écrire.	
Umpires	 Ecrire	le	NOM	(en	majuscules)	exactement	comme	sur	la	liste	officielle	du	tournoi.			

G Ajouter	les	3	lettres	du	pays	(nom	officiel,	le	même	que	sur	le	site	de	la	

CEB).	Exemple:	 Home:	 LEONE	(ITA)	 1st		base:	VERBRUGGE	

(NED)	
2nd		base:	MENENDEZ	(ESP)	 3rd	base:	KULHANEK	(CZE)	

	
Lorsqu'il	y	a	seulement	3	arbitres,	écrire	leur	nom	au	Marbre,	1ère	et	3ème	base	et	laisser	la	2ème	base	vide.	
Ne	pas	indiquer	les	prénoms	pour	être	sûr	que	tous	les	noms	figureront	dans	le	rapport	de	match	(pas	
assez	d'espace	pour	les	noms	et	prénoms).	
	
Start	time:	 Ecrire	l'heure	prévue	pour	le	début	de	la	rencontre	ex.	20:30	(avec		:)	
Weather:	 Une	 courte	 remarque	 sur	 les	 conditions	 climatiques	 comme	 "sunny"	 (ensoleillé),	
"cloudy"	(couvert),	"clear"	(dégagé),	"windy"	(venteux),	"partly	cloudy	and	raining"	(alternance	de	nuages	
et	pluie),	"drizzling"	(humide)	
	
Chart	View:	 Sélectionner	P	(pour	Pitcher)	
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Une	fois	tout	ceci	terminé	
	
>	Appuyer	sur	ENTER	
	

A	présent	sélectionner	les	équipes:		
	
>	Choisir	Team	rosters	et	après	select	a	team	

	
	

	
	
	
	
	
	
	
	
	

>	Faire	de	même	pour	l'équipe	recevante		
	
Une	fois	fait,	
>	Appuyer	sur	ESC	
	
Maintenant,	insérer	les	lineups	
	
>	Sélectionner	Lineup	Cards	 puis			>	Sélectionner	l'équipe	visiteuse		

(celle	indiquée	au-dessus)	
	 	

>	D'abord	sélectionner	l'équipe	visiteuse	

Sélectionner	l'équipe,		
utiliser	les	flèches	du	clavier	(↓↑),	et		
Appuyer	 	 sur	 ENTER	 pour	 la	
sélectionner	
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	Dans	le	cadre	rouge,	à	la	suite	du	numéro	dans	l'ordre	de	frappe:	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
>	 Ecrire	 le	 numéro	 du	 maillot	 du	 joueur	 et	 le	 programme	 insérera	 le	 nom	 du	 joueur.		
Ensuite,	écrire	la	position	défensive	(en	chiffres	1	à	9	ou	en	lettres	cf,	2b,	dh,	lf,	p,	dh,	pr,	ph…G	toujours	en	
minuscules).	
	
Il	est	également	possible	d'utiliser	la	fenêtre	jaune	pour	sélectionner	les	joueurs:		
	

>	 Cliquer	 sur	 ENTER	 pour	 accéder	 à	 la	 liste	 en	 jaune,	 et	 une	 fois	 que	 le	 curseur	 apparait,	 sélectionner	 les	
joueurs	en	utilisant	les	flèches	du	clavier	(↓↑),	et	ENTER	pour	chaque	joueur.	
	
G	 Designated	Hitter	 dh	(ou	10)	

Pinch	Hitter	 ph	(ou	11)	
Pinch	Runner	 pr	(ou	12)	
	

*	DFO:	indique	uniquement	le	joueur	défensif	(le	lanceur	si	DH).		
	

Remplir	 le	 lineup.	Pour	 le	terminer	appuyer	une	nouvelle	fois	sur	ENTER.	Attention,	 lorsque	la	saisie	
est	terminée	et	que	vous	l’avez	validée	en	appuyant	une	nouvelle	fois	sur	ENTER,	tout	changement	que	vous	
effectuerez	 après	 cela	 pourra	 conduire	 à	 un	 changement	 officiel.	
	

Quand	une	équipe	utilise	numéro	de	maillots	différents	selon	qu'elle	visite	ou	qu'elle	reçoit,	les	
numéros	‘recevants’	sont	rentrés	dans	le	logiciel.	Quand	l'équipe	visite,	vérifier	le	lineup	avec	le	roster	
officiel	 et	 choisir	 les	 noms	 en	 utilisant	 la	 liste	 dans	 le	 cadre	 jaune.	NE	 PAS	 changer	 les	 numéros	 de	
maillot	dans	le	roster.		
	

S’il	y	a	seulement	9	joueurs	dans	le	lineup,	noter	un	slash	"/"	pour	le	10e	joueur.	De	la	même	manière,	
si	 la	 rencontre	a	débuté	avec	un	 frappeur	désigné	 (dh)	et	que,	pendant	 la	 rencontre,	 il	 prend	une	position	
défensive,	modifier	le	line-up		selon	les	changements	et	noter	un	slash	"/"	pour	le	10e	joueur.		
	
G La	liste	des	joueurs	/	roster	définitif	a	été	validée	par	le	Commissaire	Technique	avant	le	début	du	
tournoi.	Pour	cette	raison,	une	équipe	n'est	pas	autorisée	à	ajouter	des	joueurs	pendant	le	tournoi.	Si	
l'OS	identifie	un	nouveau	joueur,	il	doit	informer	immédiatement	l'OC	et	le	CT	et	leur	demander	quoi	
faire.			
L'OS	doit	savoir	que	si	un	joueur	de	la	liste	joue	avec	un	numéro	différent,	il	doit	aussi	informer	le	CT	
de	la	rencontre.		 	
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Une	fois	le	lineup	des	visiteurs	saisi:	>	Répéter	cette	opération	pour	l'équipe	recevante.	
Une	fois	terminé	pour	les	2	lineups	

G 	>	Sauvegarder	toutes	les	informations	sur	la	rencontre	en	appuyant	sur			ALT	+	F		
	
G 	>	Indiquer	le	nom	du	fichier	(ici	42	–	comme	dans	le	planning	officiel	des	rencontres)	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

Impression	d'un	lineup	complet	
	

Habituellement	 dans	 les	 tournois	 in	 CEB	 aucun	 lineup	 n'est	 imprimé.	 Mais	 si	
l'organisateur	le	demande,	voici	comment	faire	:			

	
Après	 avoir	 sauvegardé	 la	 rencontre	 avec	 son	 numéro	 >	 Aller	 dans	 SCCP	 >	 Game	 Reports	 >	

Games	et	trouver	le	numéro	de	la	rencontre.	Ensuite	cliquer	sur	Reports	>	Pre-game	report.	Utiliser	les	
lignes	 'Pre-game	notes'	pour	 indiquer	 le	nom	des	scoreurs	et	CT	(comme	dans	'game	notes').	Appuyer	
sur	OK.	Dans	 la	 fenêtre	suivante,	choisir	File	>	Edit	 report	 file.	Tout	sélectionner	et	copier.	Ajouter	 la	
bannière	du	tournoi	en	en-tête	dans	un	document	Word	vierge	et	coller	votre	sélection,	vous	avez	alors	
un	joli	lineup.	Demander	à	l'OC	de	le	faire	avec	vous.	À	présent,	il	faut	imprimer	selon	les	possibilités	sur	
le	terrain.			

	
Supprimer	les	lignes	<cpi14>	et	<lpi7>	ainsi	que	le	nom	du	tournoi	(il	se	trouve	déjà	dans	l'en-

tête).	 Sélectionner	 tout	 le	 texte	 avec	 CTRL	 +	 A	 et	 changer	 la	 police	 COURIER	NEW	 taille	 8,5.Effacer	
aussi	<cpi14>	et	<lpi7>	au	milieu	de	la	page.	Toujours	s'assurer	que	le	résultat	final	tient	sur	une	seule	
page.		

	

Demander	 ensuite	 à	 l'organisateur	 le	 format	 souhaité.	 Il	 est	 possible	 d'imprimer	 le	 document	
avec	ou	sans	statistiques		Ouvrir	SCCP	>	Game	Reports	>	Games	>	Select	the	game	>	Reports	>	Pre-game	
report	 pour	 avoir	 un	 document	 sans	 statistiques.	Mais	 en	 allant	 dans	 Settings	 >	 Load	 stat	 files	 avant	
d'ouvrir	Reports	>	Pre-game	report,	les	statistiques	apparaissent.	.	

	
Toujours	envoyer	le	pre-game	report	à	l'OC.	L'Operateur	Central	fera	la	dernière	vérification	et	

transfèrera	à	l'organisation.	C'est	l'organisateur	qui	est	en	charge	de	la	distribution	du	document.	C'est	
seulement	 lors	 des	 championnats	 d'Europe	 seniors	 que	 le	 document	 est	 envoyé	 par	 mail	 à	
media@baseballeurope.com.	 	
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Bulletin	d'avant	match	sans	les	statistiques	

	
	

Bulletin	d'avant	match	avec	les	statistiques	
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 Statistiques	sur	internet	
	

Comme	la	rencontre	est	en	live,	nous	avons	besoin	d'afficher	les	statistiques,	il	faut	donc	les	
charger,		

	
>	Aller	dans	Statistics,	depuis	Main	Menu:	

	

	
>	Sélectionner	Load	stat	files:	

	
	

>	Répondre	Y	(yes)	pour	les	deux	équipes,	quand	la	question	apparaît.	
	

Maintenant	 tout	 est	 prêt	 pour	 débuter	 la	 rencontre.	 Comme	 il	 peut	 arriver	 que	 des	
modifications	 interviennent	 avant	 le	 début	 de	 la	 rencontre	 sans	 que	 ce	 soit	 considéré	 comme	 des	
changements,	il	faut	attendre	que	le	lineup	soit	définitif	avant	d'aller	plus	loin.	Le	lineup	définitif	est	
remis	par	 le	coach	à	 l'arbitre	 lors	de	 la	réunion	au	marbre,	 il	doit	 indiquer	s'il	y	a	des	modifications.	
L'arbitre	en	chef	donne	son	lineup	au	commissaire	technique	et	communique	les	informations.	Si	l'OS	
n'entend	pas,	la	rencontre	peut	commencer	malgré	tout.			

	
>	Pour	revenir	à	un	menu	précédent	ou	pour	sortir	d'une	fenêtre,	appuyer	sur	ESCape			
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>	Retourner	maintenant	dans	le	Main	Menu	(utiliser	la	touche	ESC	si	besoin)	et	sélectionner	Scoresheet.		

	
	

>	Sélectionner	Plays	

	
Le	programme	va	afficher	automatiquement	une	fenêtre	comme	celle-ci	(Seulement	si	c’est	la	première	fois	
que	vous	ouvrez	Plays).		

	
>	APPUYER	sur	Enter	jusqu'à	ce	que	les	lineup	disparaissent.		
Après	cet	instant,	toute	modification	dans	un	line	up	sera	considérée	comme	un	changement.		 	
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Si	 cela	 arrive,	 il	 faut	 supprimer	 la	 rencontre	 et	 recommencer.	 Si	 vous	 ne	 savez	 pas	 comment	 faire	
contactez	l'OC.		
	
À	 présent,	 insérer	 le	 nom	 des	 scoreurs	 et	 des	 commissaires	 techniques:	
>	Appuyer	sur	ALT	+	N	
Écrire	‘Scorers	–‘	et	le	nom	du(es)	scoreur(s)	officiel(s)	/	data	entry	(OS):	nom	de	famille	en	majuscules	et	la	
première	lettre	du	prénom	seulement	en	majuscule,	le	reste	en	majuscule	(LETTRES	DU	PAYS).	Ne	pas	noter	
de	virgule	entre	le	nom	et	le	prénom	mais	seulement	entre	2	noms.	Saisir	les	noms	dans	l'ordre	en	faisant	
figurer	le	nom	de	l'OS	en	dernier.		

	
>	 Appuyer	 sur	 Enter	 pour	 confirmer	 les	 noms	 jusqu'à	 atteindre	 la	 ligne	 inférieure	 du	 cadre	 noir	 et	 qu'il	
disparaisse.	
	

	

Dans	ce	cadre	noir,	écrire	toutes	les	"Game	Notes"	au	cours	de	la	rencontre,	par	exemple	les	arrêts	de	jeu	
pour	 pluie	 ("rain	 delay")	 ,	 panne	 d'éclairage	 ("lights	 breakdown")	 et	 autres,	 mais	 jamais	 les	 visites	 au	
lanceur.	Les	informations	du	Report	Notes	seront	ajoutées	au	rapport	de	match	mais	pas	au	play-by-play.	
	
☺ Vous	pouvez	également	ouvrir	cette	fenêtre	"Notes"	à	partir	du	menu	Lineup	summary.	
	
G Lorsque	vous	avez	complété	toutes	les	données,	N'OUBLIEZ	PAS	DE	SAUVEGARDER	(ALT	+	F)	et	ENTER	
 

G Si	 vous	 voulez	 insérer	 le	 compte	 des	 lancers	 ("pitches	 count"),	 avant	 de	 commencer	 à	 scorer,	 il	 faut	
activer	cette	option	pour	qu'elle	apparaisse	sur	l'écran	et	sur	Internet.	
	
>	Aller	dans	SCCP	>	Game	Reports	>	Settings	>	Report	Options	>	activer	les	trois	(3)	premières	options	
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>	Cliquer	sur	OK	et	fermer	la	fenêtre	avec	exit	
	
G	Pour	voir	comment	insérer	le	compte	des	lancers		? page	28.	
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 Mise	en	ligne	de	la	rencontre		
	

Après	tout	ceci,	il	faut	mettre	la	rencontre	en	"live".	
	
>	Revenir	dans	Stat	Crew	Control	Panel	(SCCP)	
	
>	Sélectionner	Game	reports	
	
>	Cliquer	sur	Games	et	sélectionner	la	rencontre	à	mettre	en	ligne	:		

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	 Au	cas	où	vous	ne	trouveriez	pas	votre	rencontre,	cliquez	sur	"Teams"	et	vérifiez	que	"All	teams"		est	
bien	sélectionné.	Ensuite,	retournez	dans	Games	et	sélectionnez	votre	rencontre.	
	
Une	fois	la	rencontre	sélectionnée,	cliquer	OK	et	aller	sur	
	

>	Live	>	Live	HTML	Tailoring	

	

Insérer	le	logo	des	équipes	dans	le	cadre	"Visitor	logo"	et	"Home	logo"	afin	qu'ils	soient	visibles	
sur	Internet.	Le	webmaster	aura	précédemment	inséré	les	logos	sur	le	serveur.	
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>	Ecrire	les	3	lettres	(exactement	comme	indiqué	par	l'OC)	désignant	chaque	équipe	+	.gif			
Si	l'OC	n'est	pas	joignable,	vérifier	dans	le	dossier	sur	le	serveur	les	initiales	à	utiliser.		
	

Si	vous	utilisez	Gametracker	pour	le	tournoi,	vous	n’avez	pas	besoin	d’insérer	les	logos	dans	le	HTML	
tailoring.	L'OC	vous	indiquera	ce	qu’il	faut	faire.	
	
Une	fois	les	logos	insérés:		
>	Cliquer	sur	OK	
	
Puis,	pour	s’assurer	que	les	moyennes	offensives	seront	visibles	dans	le	play-by-play	:		
>	Cliquer	sur	Settings						>	Load	Stat	files							>	Répondre	Yes	pour	les	deux	équipes.	

	
	
Ensuite,	réaliser	la	dernière	étape	pour	mettre	en	ligne	la	rencontre	en	direct	:			
	
>	Sélectionner	Live	>	Live	setup	
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Avant	le	début	du	tournoi,	l'OC	vous	donnera	les	paramétrages	du	FTP	tels	qu’ils	doivent	être	remplis.	
C’est	 seulement	avec	 ces	données	que	vous	pourrez	 vous	 connecter	 au	 serveur	et	que	 le	play-by-play	 sera	
possible.	Maintenant	..		
	
G La	case	Activate	doit	être	cochée:	þ 
 
G	Puis	cliquer	sur		OK		quelques	minutes	avant	le	début	de	la	rencontre.		
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
Le	cadre	"Live	message	text"	peut	être	utilisé	pour	donner	des	 informations	supplémentaires	destinées	aux	
internautes,	ex.	GAME	DELAY.	

G Ne	pas	oublier	d’effacer	le	texte	une	fois	que	la	situation	a	changé	

	
	 Après	ceci,		NE	PAS	fermer	la	fenêtre	devant	vous	ou	sinon	il	n'y	aura	pas	de	play-by-play.	Réduire	la	
fenêtre.	
	
☺ Parfois,	s'il	y	a	un	problème	avec	la	connexion	Internet,	vous	pouvez	essayer	de	réactiver	le	programme.	
Dans	ce	cas,	revenir	dans	cette	fenêtre,	désactiver	la	case	ACTIVATE	puis	activer	de	nouveau	en	cliquant	
sur	la	case	
Ou	essayer	de	transmettre	les	fichiers	manuellement.	Pour	cela,	aller	dans	Game	Reports	>	Live	>	Send	Stat	
Files	
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	 Enfin,	avant	le	début	de	la	rencontre:		

Indiquer	le	"live"	avec	le	site	de	résultats	
	

G Il	faut	préciser	sur	le	site	que	la	rencontre	est	en	"live".	
>	Entrer	sur	le	site	de	résultats	(L'OC	vous	donnera	le	lien).	

	
Pour	accéder	à	cette	page	web,	suivre	les	instructions	données	par	l'OC.	
Par	exemple	 -	Cliquer	sur	la	bordure	bleue	du	tableau	juste	au	milieu.	
	 -	Des	informations	vous	seront	alors	demandées:	
	 	 Login	:	__________			(fourni	par	le		Webmaster	CEB		/	OC)	 	
	 	 Password:	________(fourni	par	le	Webmaster	CEB	/	OC)	
>	Cliquer	sur	OK	
	

>	Cliquer	sur	le	numéro	de	la	rencontre		
	
>	Ecrire	le	mot	“Live”	dans	la	case	"Inning"					

	
>	Cliquer	sur	UPDATE	
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 Affichage	du	compte	des	lancers	
	

Dans	toutes	les	compétitions	CEB,	le	compte	des	lancers	de	chaque	rencontre	sera	suivi.	Pour	
cela,	activer	les	options	pour	afficher	ces	données	à	l'écran	/	sur	Internet	(vérifier	comment	page	22).	

	
>	Aller	dans	le	menu	Scoresheet,	>	Sélectionner	Options	

	
>	Aller	dans	pitch	count	in	narr	>	Taper	Y	(pour	Yes).	
Si	vous	utilisez		ALT	+	O	pour	entrer	dans	Options,	choisir	d'abord	S	pour	Scoresheet	options,	et	ensuite	
taper	Y	pour	Pitch	count	in	narr.	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

Appuyer	sur	Enter	jusqu'à	la	disparition	de	la	fenêtre.	Retourner	dans	Plays.	
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La	rencontre	débute		
	

	 Une	fois	que	vous	avez	tout	préparé,	vous	êtes	prêt	à	commencer	le	scorage.	Vous	utiliserez	
principalement	le	menu	SCORESHEET	>	PLAYS:		

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	Le	programme	affichera	une	fenêtre	avec	le	lineup	de	l'équipe	à	l'attaque	et	un	schéma	du	terrain	(avec	le	
frappeur	au	marbre	et	les	coureurs	sur	bases).	Attention,	la	fenêtre	verte	(montrant	le	schéma	du	terrain)	
se	déplacera	du	côté	gauche	de	l’écran	à	partir	de	la	6ème	manche..	
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Ensuite,	quand	le	batteur	se	présente	:	>	Appuyer	sur	P	dans	la	fenêtre	verte	qui	servira	à	insérer	les	jeux.		

>	Indiquer	une	lettre	pour	chaque	lancer,	en	utilisant	le	clavier,	comme	indiqué	sur	la	capture	en-dessous:		
	

	

Quand	 le	 compte	 est	 de	 2	 prises	 et	 que	 vous	 appuyez	 sur	 K,	 l'indication	 KL	 apparaîtra	
automatiquement	sur	la	ligne	grise;	tout	comme	si	vous	appuyez	sur	S	dans	ce	cas,	le	logiciel	indiquera	
automatiquement	KS.				
Aussi,	lorsque	vous	indiquez	la	4ème	balle	(B),	un	BB	est	attribué	au	batteur.	Et	aussi,	le	H	donne	un	HBP.	
Quand	 il	 y	 a	 un	 jeu,	 appuyer	 sur	 P	 et	 saisir	 le	 jeu	 sur	 la	 ligne	 grise	 du	 batteur.	 Le	 logiciel	 compte	
automatiquement	un	lancer	au	lanceur.		

	

	 Si	 le	manager	 de	 l'équipe	 en	 défense	 informe	 l'arbitre	 de	 son	 souhait	 d'accorder	 un	 but	 sur	 balles	
intentionnel	au	batteur,	ne	pas	saisir	de	lancer	(ou	arrêter	après	le	dernier	lancer	avant	l'annonce),	appuyer	
sur	ESCape	et	indiquer	IBB	sur	la	ligne	grise.		
	

Une	erreur	de	saisie?	Appuyer	sur	D	pour	effacer	le	dernier	lancer	et	le	corriger.	Par	exemple,	si	
vous	appuyez	sur	K	ou	lieu	de	S	pour	la	3e	prise.	La	ligne	grise	indique	un	KL	mais	vous	savez	que	c'est	
faux.	Effacer	 le	KL,	appuyer	sur	P	pour	retourner	dans	 le	pitch-by-pitch.	Appuyer	sur	D	pour	effacer	 le	
dernier	lancer	et	appuyer	sur	S.	Maintenant,	KS	apparaît	sur	la	ligne	grise.		
	

Quand	un	 lanceur	tente	un	pick	off	 	 sur	un	coureur	et	ne	réussit	pas,	sortir	de	 la	 fenêtre	du	
pitch-by-	pitch	en	utilisant	ESCape	et	taper	FPO	(Failed	Pick	Off)	pour	le	coureur.		 	
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Après	avoir	confirmé	avec	Enter,	le	curseur	revient	sur	la	ligne	du	batteur,	taper	P	et	continuer	

les	 lancers.	 Le	 faire	une	 fois	 seulement	 car	 il	 y	 a	un	 risque	de	perdre	 le	 compte	en	 cours.	 Si	 vous	
attendez	 après	 avoir	 tapé	 FPO	pour	 voir	 si	 un	 autre	 FPO	 se	 produit,	 il	 est	 possible	 d'en	 noter	 un	
autre,	mais	ne	jamais	passer	de	FPO	à	la	fenêtre	des	lancers	plus	d'une	fois.			

G Se	 rappeler	que	 cette	option	nécessite	une	attention	 complète	et	 continue	de	 la	part	 de	 l'OS.	 Lorsque	
vous	travaillez	avec	une	feuille	de	lancers,	vérifiez	après	chaque	batteur	le	total	des	lancers	et	effectuez	les	
corrections	si	nécessaires,	notamment	si	un	FPO	a	été	saisi.			
	
Quand	il	y	a	un	jeu	
>	Saisir	le	jeu	sur	la	ligne	grise	correspondante	(pour	le	batteur	ou	le	(s)	coureur(s)),	en	utilisant	la	liste	des	
symboles.	La	plupart	d'entre	eux	sont	identiques	aux	conventions	de	scorage	CEB.			
	
C	La	liste	complète	des	symboles	se	trouve	en	annexe..	
	
	 S'il	faut	saisir	un	jeu	pour	le	batteur	et	le(s)	coureur(s),	saisir	d'abord	le	jeu	du	batteur,	appuyer	sur	
Enter	et	la	ligne	grise	se	déplace	vers	la	case	des	coureurs.	Saisir	alors	la	suite	du	jeu.		
	 S'il	faut	saisir	un	jeu	SEULEMENT	pour	un	coureur	(par	exemple	un	vol	de	base,	un	retrait	ou	un	FPO	
(Failed	Pick	Off)	:	
	
>	Appuyer	sur	Enter	et	le	curseur	se	déplace	sur	la	ligne	grise	du	premier	coureur	sur	base	:		

	
	

	

	

	

	

	

	

	

	

	

	

Une	fois	le	jeu	saisi,	le	logiciel	affiche	un	résumé	de	la	saisie.	Le	lire	attentivement	pour	vérifier	si	tout	est	
exact.	Ensuite	Appuyer	sur	Enter.		
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Quand	la	description	ne	correspond	pas	au	jeu,	il	faut	corriger	la	saisie.	Tout	est	expliqué	page	35.	
	

Comme	le	logiciel	ajoute	les	lettres	correspondant	aux	RBI	et	points	non	mérités	sur	la	ligne	grise,	le	
jeu	peut	être	trop	long	pour	rentrer	sur	la	ligne.	Dans	ce	cas,	le	play-summary	s'affiche	et	indique	‘play	too	
long	to	fit	RBI’s,	split	into	separate	plays’	ou	‘play	too	long	to	fit	unearned	runs,	use	separate	plays’.	Lorsque	
cela	arrive,	séparer	le	jeu	de	manière	logique	et	laisser	ensemble	ce	qui	va	ensemble.	Par	exemple,	quand	un	coup	
sûr	(double	ou	triple)	est	suivi	d'une	erreur,	garder	le	coup	sûr	et	les	avances	ensemble	et	faire	un	nouveau	jeu	avec	
l'erreur	et	les	avances	liées.		
	

A	la	fin	de	chaque	demi-manche,	le	logiciel	affiche	une	résumé	:	#	inning,	R-H-E-LOB.	Là	aussi,	il	faut	
confirmer	avec	Enter,	et	le	logiciel	sauvegardera	le	fichier	de	la	rencontre	automatiquement.			

	
	

Vérifier	entre	les	manches	avec	la	fonction	ALT+D	les	numéros	d'uniforme	sur	le	terrain.	Grâce	à	cela,	
il	 est	 facile	de	voir	 les	 changements.	 Se	 rappeler	que	 si	une	équipe	a	des	numéros	différents	 selon	qu'elle	
reçoit	ou	qu'elle	visite,	les	numéros	ne	vont	pas	correspondre.	Utiliser	une	feuille	à	part	dans	ce	cas!		
	

Parfois	nous	avons	besoin	d’ajouter	des	commentaires	au	play-by-play		pour	donner	des	explications	
supplémentaires.	Par	exemple	les	visites	au	lanceur,	‘:::	Coaching	visit	to	mound	:::’.	Pour	d’autres	exemples,	
consulter	la	liste	dans	les	annexes	page	54.	Ne	jamais	ajouter	un	commentaire	sur	l'expulsion	d'un	joueur!!	

	
De	plus,	pour	saisir	des	retraits	automatiques	(Out	By	Rules),	commencer	par	un	commentaire	avant	de	

saisir	le	jeu	sur	la	ligne	grise.	Il	existe	un	symbole	spécifique	pour	l’interférence	du	batteur,	pour	toutes	les	autres	
actions	particulières,	il	faut	utiliser	les	commentaires.		

	
	 Il	 est	 très	 important	 de	 saisir	 d'abord	 	 le	 commentaire	 avant	 de	 saisir	 le	 jeu.	 Tout	 particulièrement	
lorsqu’il	y	a	déjà	deux	retraits	dans	la	manche,	si	vous	indiquez	d’abord	le	jeu,	le	programme	passera	à	la	demi-
manche	suivante	et	votre	commentaire	apparaîtra	pour	la	mauvaise	équipe	et	dans	la	mauvaise	demi-manche			 		
	

	Pour	insérer	un	commentaire	:>	Appuyer	sur	ESCape.	Dans	le	menu	scoresheet,	sélectionner	Comment.	
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Saisir	le	commentaire	et	appuyer	sur	Enter.	Retourner	maintenant	dans	Plays	
	

	

Des	exemples	pour	les	commentaires	pour	les	Out	by	rule,	coaching	visit	ou	suspended	games	se	
trouvent	page	53.	
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 Comment	corriger	les	erreurs	lors	de	la	saisie	
	

☺Tout	d'abord,	il	est	recommandé	d'être	patient:	ne	pas	oublier	qu'un	scoreur	est	à	proximité	et	pourra	vous	
répétez	les	jeux	si	vous	avez	fait	une	erreur	ou	si	vous	avez	manqué	une	action.	
	
a) Pour	effacer	simplement	le	dernier	jeu:		
	
>	(depuis	la	fenêtre	de	jeu)	Appuyer	sur	ESCape		pour	revenir	dans	le	menu	Scoresheet,		
	
>	Sélectionner	Delete	from	end	et	la	dernière	action	est	effacée	automatiquement.	

	
	

G Sachez	que	lorsqu'on	utilise	‘Delete	from	end’	on	efface	également	le	compte	des	lancers	de	ce	jeu,	si	le	
compte	des	lancers	n'a	pas	été	noté,	utiliser	l'option	b)	

	
Pour	retourner	au	scorage,	sélectionner	le	sous	menu	Plays.	Commencer	la	saisie	du	compte	des	lancers	de	
nouveau	et	saisir	le	jeu	exact.			

	
b) Pour	corriger	un	jeu	précédemment	saisi	:	UTILISER	LE	PLAY	EDITOR.	

	
>	Appuyer	sur	ESCape	pour	revenir	au	menu	Scoresheet.	
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>	Sélectionner	Edit	Plays		pour	ouvrir	le	PLAY	EDITOR:	(ou	utiliser	le	raccourci:	ALT	+	E)	

	
Si	vous	avez	besoin	de	changer	d'équipe	appuyez	sur	ALT	+	T.	
	
Ensuite,	le	curseur	se	place	sur	le	dernier	jeu	rentré	indiqué	par	un	carré	blanc.	
Pour	le	corriger,	appuyer	sur	ENTER,	et	saisir	la	nouvelle	action.		
	
Vous	pouvez	également	vous	déplacez	dans	la	rencontre	jusqu'au	jeu	à	corriger	(comme	dans	l'exemple)		
>	En	utilisant	les	flèches	du	clavier	(↑↓	déplacement	vertical,	ou	→←,	pour	passer	d'une	manche	à	l'autre).	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	 Dans	ce	sous-menu	une	aide	apparait	avec	les	lettres	à	utiliser	pour	aller	plus	vite.	Par	exemple,	pour	
modifier	 le	 lineup.	 D'abord	 trouver	 l'endroit	 exact	 où	 insérer	 le	 changement.	 Appuyer	 sur	 L	 'lineup	 fix',	
modifier	le	lineup	et	le	fermer	avec	CTRL	+	Enter.	
	
	 Si	vous	avez	besoin	de	modifier	plusieurs	jeux	appuyer	sur	la	barre	ESPACE	du	clavier.	
Pour	quitter	le	Play	Editor,	et	reprendre	le	scorage	de	la	rencontre	appuyer	sur	ENTER	>	Plays	
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c)		Pour	modifier	un	point	non	mérité	en	un	point	mérité		

	
Comme	décrit	 précédemment,	 aller	 sur	 l’action	qui	 a	permis	de	 faire	 rentrer	 le	point	non	mérité	 (si	 le	

point	a	été	inscrit	grâce	à	un	double	du	8e	frappeur	de	l’alignement,	déplacer	le	carré	blanc	jusqu’au	double).	Le	
point	est	indiqué	comme	UE	(unearned).	Sélectionner	le	et	effacer	les	lettres	UE.		
	
Le	 programme	 va	 alors	 demander	 une	 confirmation	:	 "Is	 Mazzanti	 G's	 run	 an	 Earned	 Run?	 Y)es	 N)o	 T)eam	
unearned".	Confirmer	en	appuyant	sur	la	touche	Y	et	le	point	devient	mérité.		
	
Appuyer	sur	ENTER,	retourner	dans		le	menu	scoresheet	et	continuer	à	scorer	dans	Plays.		
	
d)	Pour	modifier	un	point	mérité	en	un	point	non	mérité		
	

Comme	décrit	 précédemment,	 aller	 sur	 l’action	qui	 a	permis	de	 faire	 rentrer	 le	point	non	mérité	 (si	 le	
point	a	été	 inscrit	 grâce	à	un	double	du	8e	 frappeur	de	 l’alignement,	déplacer	 le	 carré	blanc	 jusqu’au	double).	
Appuyer	sur	ENTER	et	ensuite	CTRL	+	ENTER.		

	
Le	 programme	 vous	 demande	 "Enter	 the	 number	 of	 RBI's	 (0-x)".	 Répondre	 à	 cette	 question.	 Le	

programme	vous	demande	ensuite	"Is	Mazzanti	G's	run	an	Earned	Run?	Y)es	N)o	T)eam	unearned".	Confirmer	
en	appuyant	sur	la	touche	N	et	le	point	devient	non	mérité.		

	
Appuyer	sur	ENTER,	retourner	dans		le	menu	scoresheet	et	continuer	à	scorer	dans	Plays.	
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 Remplacements	et	changements	des	positions	
	

☺Il	est	fortement	recommandé	d'utiliser	les	raccourcis	clavier:	
	
F5	 Pour	modifier	le	lineup	défensif	(changement	de	l'équipe	en	défense)	

F6	 Pour	insérer	un	changement	de	lanceur	

F7	 Pour	insérer	un	Pinch	Hitter	

F8	 Pour	modifier	le	line	up	offensif	(changement	de	l'équipe	en	attaque	ou	sur	base	(=	pinch	runner))	

ALT	+L		 Pour	faire	apparaître	la	fenêtre	des	lineups	

	
*	Changements	de	lanceurs:	Appuyer	sur	F6	>	écrire	le	numéro	de	maillot	ou	sélectionner	le	nom	dans	la	liste	>	
ENTER.	
	

En	 cas	 de	 Tie-Break	 débutant	 avec	 un	nouveau	 lanceur,	 il	 est	 très	 important	 de	 saisir	d'abord	 le	
nouveau	lanceur	avant	de	placer	les	coureurs	sur	base.	Si	ce	n'est	pas	fait	dans	l'ordre,	les	possible	points	
des	coureurs	de	tie-break	seront	attribués	au	lanceur	précédent.	

	
*	Changements	défensifs:	
Appuyer	sur	F5	
>	Sélectionner	le	joueur	concerné	par	le	changement	
	
>	Écrire	le	numéro	de	maillot	du	nouveau	joueur	et	sa	position	ou	modifier	celle	du	joueur	remplacé	(comme	
indiqué),	ensuite	continuer	avec	les	autres	changements	de	la	même	façon.		
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
G	Appuyer	sur	ENTER	jusqu'à	la	fin	du	line	up	pour	que	les	changements	soient	effectifs	(ou	utiliser	CTRL	+	
ENTER)	
Si	vous	appuyez	seulement	sur	ESCape,	les	changements	ne	seront	PAS	effectués.		
	
*	Remplacements	
Pour	un	nouveau	frappeur	appuyer	sur	F7	
Écrire	le	numéro	de	maillot	ou	sélectionner	le	nom	dans	la	liste	>	ENTER	et	écrire	ph	pour	la	position.	
	
Appuyer	sur	F8	pour	un	remplacement	dans	le	lineup	offensif	
Écrire	le	numéro	de	maillot	du	nouveau	joueur	et	sa	position	défensive.	S'il	y	a	plusieurs	changements	
simultanément,	vérifier	que	tous	les	joueurs	ont	la	bonne	position.	
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Changement	de	DH:	Saisir	le	numéro	de	maillot	ou	sélectionner	le	nom	dans	la	liste	>	Saisir	ph	ou	
pr	(qui	peuvent	s'appliquer)	dans	la	colonne	position.	Après	cette	demi-manche,	modifier	la	position	ph	ou	
pr	en	dh,	si	le	joueur	ne	prend	pas	de	position	défensive.		
	

Quand	un	changement	implique	un	ph/pr,	il	manquera	une	position	défensive	au	logiciel.		
Une	nouvelle	fenêtre	s'ouvre	indiquant	"	the	following	defensive	positions	are	not	filled:	xx"	
Appuyer	sur	Enter	et	la	fenêtre	des	line	up	s'ouvre,	changer	alors	les	ph/pr	en	positions	défensives.	
Appuyer	sur	Enter	jusqu'à	la	fin	de	la	liste	(ou	utiliser	CTRL	+	Enter)	pour	confirmer	le(s)	nouvelle(s)	
position(s).	
Si	cela	se	produit	alors	que	la	rencontre	est	terminée,	appuyer	simplement	sur	ESCape.	À	ce	moment	de	la	
rencontre,	il	n'y	a	pas	de	position	défensive	à	renseigner.		

	
Lorsque	le	lineup	n'a	plus	10	joueurs,	utiliser	‘/’	pour	la	position	DFO.	

	
*	Pour	vérifier	les	changements	:	>	Aller	dans	le	sous	menu	LIST	SUBS	(ou	utiliser	CTRL	+	L)	
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Wrap	up	(clore)	la	rencontre	
	

Lorsque	 la	 rencontre	 est	 terminée,	 il	 reste	 plusieurs	 choses	 à	 faire,	 notamment	 si	 le	 scorage	 était	 en	
direct.	Réaliser	les	différents	points	dans	l'ordre.	
	
>	Aller	dans	le	menu	SCORESHEET	>	WRAP	UP	(or	use	ALT	+	W)	
	

Appuyer	sur	ENTER	et	remplir	les	lignes	W-T-L,	vérifier	les	résultats	des	équipes	concernant	leurs	
victoires	et	défaites	jusque-là.	Ajouter	la	rencontre	aux	résultats.			

	
	 Appuyer	sur	ENTER	jusqu'à	la	ligne	du	winning	pitcher	pour	indiquer	son	nom.		

Pour	cela,	utiliser	les	flèches	et	choisir	le	nom	sur	fond	gris.	Vérifier	le	nom	avec	le	scoreur	de	la	rencontre.	Faire	
la	même	chose	avec	le	save	et	la	défaite.	Ne	pas	indiquer	de	chiffre	pour	W-L/Save	(l'OC	le	fera).	

Indiquer	la	durée	de	la	rencontre	(ici:	3:02)	et	le	nombre	de	spectateurs	(700)	>	Enter.	
	

Ensuite	une	liste	‘Stat	name	team’	apparaît.	Appuyer	sur	Enter	jusqu'à	disparition	de	la	liste.	Il	n'y	a	
rien	d'autre	à	faire	(appuyer	sur	Enter	pour	chaque	ligne).			
	
Sauvegarder	la	rencontre	(ALT	+	F)	et	QUITTER	avec	ALT	+	Q.	
	

Maintenant,	après	avoir	vérifié	que	 la	rencontre	en	 ligne	apparaît	comme	terminée	(le	mot	 'final'	
doit	être	inscrit),	la	première	chose	à	faire	est	de	désactiver	le	Live	Setup.	

	
Ouvrir	la	fenêtre	Game	Reports	qui	était	réduite	et	aller	dans	>	Live	>	Live	setup	>	décocher	la	case	Activate.	
	
C À	présent,	vous	pouvez	également	voir	ou	imprimer	la	BOX	SCORE	
Dans	la	fenêtre	Game	Reports	>	Cliquer	sur	Compos	>	File	>	Print	
	

	 Se	Souvenir	que	:	Si	vous	remarquez	quelque	chose	à	modifier,	vous	pouvez	utiliser	le	Play	Editor.		Après	
avoir	utilisé	 le	Play	Editor	REFAIRE	 LE	WRAP	UP	 sinon	vos	modifications	n’apparaîtront	pas	dans	 la	 rencontre.			
Ouvrir	la	connexion	Live	setup	de	nouveau,	cocher	la	case	Activate	et	charger	les	fichiers	corrigés.		
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Génération	des	fichiers	de	la	rencontre	
	

Aller	dans	SCCP	>	Game	Reports	>	Games	>	Sélectionner	la	rencontre	>	OK	

	
Avant	de	générer	le	fichier,	vérifier	que	les	bonnes	cases	sont	cochées,		

Aller	dans	HTML	–	SETUP	et	cocher	les	cases	‘Composite	box’,	‘Play-by-play’	et	‘Line	score’		

À	présent	>	HTML	 >	Generate	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

Ensuite	le	programme	vous	indique	le	"chemin"	avec	le	disque	et	la	direction	du	fichier	avec	l'extension	".htm"	
créé	pour	cette	rencontre.	

	

	
Rappelez-vous	du	chemin	et	du	nom	du	fichier	parce	que	vous	en	aurez	besoin	pour	mettre	le	fichier	sur	le	
serveur	(dans	l'exemple,	d:\ceb\2010\euro)	et	pour	l'exporter	(40.htm),	qui	sera	dans	le	sous-dossier	'HTML'.	

	

.	
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Insertion	de	la	box	score	sur	le	site	web	
	

C'est	 la	même	procédure	que	celle	mentionnée	page	9	qui	précise	comment	télécharger	des	fichiers	depuis	 le	
serveur	avant	la	rencontre.	Sans	les	captures	d'écran,	voici	un	bref	rappel.			

	
>	Ouvrir	le	logiciel	‘Leech	FTP’.	

	
>	Entrer	dans	le	serveur	du	site	en	double	cliquant	sur	l'icône	‘livre’		

	
>	Double	cliquer	sur	l'icône	du	serveur	dans	la	partie	droite	de	la	fenêtre		

	
Une	fois	connecté,	3	‘fenêtres’	apparaissent:	
(Pour	revenir	à	un	dossier	supérieur,	double	cliquer	sur	l'icône	du	dossier	avec	une	flèche	bleue).		

	
>	Maintenant	ouvrir	le	dossier	“Games”	dans	la	partie	droite	et	double	cliquer	dessus			
>	 Sélectionner	 le	 fichier	 de	 la	 rencontre	 avec	 l'extension	 .htm,	 qui	 se	 trouve	 dans	 le	 dossier	 HTML	 de	 la	
directory	du	tournoi		

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
>	Faire	un	“glisser	déposer”	du	fichier	.htm	de	la	fenêtre	du	centre	vers	celle	de	droite.	
	

G L'OS	doit	seulement	ouvrir	le	dossier	‘GAMES’.	
G Pour	cela,	il	est	recommandé,	lors	du	premier	jour	de	la	compétition,	de	sélectionner	et	mettre	en	place	ces	
dossiers.	 Les	 jours	 suivants,	 ils	 apparaîtront	 automatiquement.	 Et	 il	 est	 recommandé	 de	 les	 conserver	 en	
l'état	chaque	jour.		

	
POUR	SORTIR	DU	LOGICIEL	LEECH	FTP		

	

G NE	PAS	fermer	avec	la	case	X	en	haut	à	droite	de	la	fenêtre.	
	
>	D'abord	(1),	cliquer	sur	l'icône	“prise”	(pour	se	déconnecter	du	serveur)	

>	Ensuite	(2),	cliquer	sur	l'icône	"personnage"	(pour	quitter	le	programme)	
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Mise	à	jour	du	résultat	de	la	rencontre	sur	le	site	Internet	
	

>	Entrer	dans	le	site	de	la	compétition,	comme	expliqué	page	27.	Cliquer	sur	le	numéro	de	la	rencontre	
>	Écrire	le	score	final	pour	l'équipe	recevante	(H)	et	Visiteuse	(V):	

	
>	Inning	box:	Effacer	le	mot	'live'	et	écrire	le	nombre	de	manches	jouées,		seulement	s'il	n'y	en	a	pas	eu	9	
(ex.	7-10-11).	(S'il	y	a	eu	9	manches,	ne	rien	écrire,	ne	pas	utiliser	non	plus	de	demi-manches)	

	
>	STANDING	Box:	sélectionner	Played	

	
	
	

	
>	Cliquer	sur	UPDATE,	(situé	en	bas	de	la	fenêtre)		

Quitter	avec	>	Back	to	List	>	Exit	
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Exportation	de	la	rencontre	et	envoi	des	fichiers	sur	le	serveur	
	

G	Avant	le	début	de	la	compétition,	l'OC	créera	un	dossier	spécifique	pour	l'exportation	des	fichiers.	Sinon,	
vous	pouvez	le	faire	sur	le	disque	dur	de	votre	ordinateur.	(Par	exemple	C:\CEB\2010\EURO\Export)	

	
G	 Il	 est	 recommandé	 que	 tous	 les	 OS	 utilisent	 le	 même	 système	 de	 dossiers	 pour	 uniformiser	 le	 travail	 des	
scoreurs.		
	

	
>	Aller	dans	SCCP	>	Utilities	/	Roster	Maintenance				>	Export	Game	

	

Le	programme	demande	le	nom	du	dossier:	Confirmer	avec	OK	(ou	en	écrire	un	nouveau;	toujours	utiliser	un	
dossier	‘Export’).	

	
Ensuite,	la	liste	des	rencontres	apparait:		
>	choisir	la	rencontre	à	exporter,	en	cliquant	dessus	et	confirmer	avec	OK.	
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>	Confirmer	avec	OK		le	nom	de	la	rencontre	sélectionnée.	

	
	 Le	programme	a	maintenant	généré	les	trois	fichiers	de	la	rencontre.	Ils	se	terminent	par	l’extension	
.GAM	.POS	et	.PLY.		
Ce	sont	les	trois	fichiers	dont	l'OC	a	besoin.	Envoyer	maintenant	ces	fichiers	à	l'OC.		
	
>	Utiliser	Leech	FTP	pour	se	connecter	au	serveur.	
	
>	Glisser	et	Déposer	les	3	fichiers	de	la	rencontre	sur	le	serveur	dans	le	dossier	GAMES.	
	
>	Rafraîchir	la	fenêtre	de	droite,	afin	de	voir	si	le	glisser	déposer	a	réussi.		
	
>	Fermer	la	connexion	Leech	FTP		
	
>	Informer	l'OC	via	Skype	que	les	fichiers	sont	sur	le	serveur.		
	
Ou..	
	
>	Glisser	Déposer	les	3	fichiers	de	la	rencontre	dans	la	fenêtre	Skype.	L'OC	pourra	les	sauvegarder	
immédiatement	sur	son	ordinateur.			
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Listes	des	Symboles	utilisés	pour	le	scorage	
	
G 	 //	(Coureurs):	indique	que	le	jeu	affecte	à	la	fois	le	frappeur	et	le(s)	coureur(s).			
	

G 	 Dans	 tous	 les	 exemples	 et	 la	 liste	 de	 symboles,	 vous	 verrez	UN	 ESPACE	 entre	 les	 symboles	 et	 les	
chiffres:	CET	ESPACE	DOIT	ETRE	INDIQUÉ	AVEC	LA	BARRE	ESPACE	DU	CLAVIER.	(C'est	le	cas	pour	la	plupart	des	
jeux,	mais	pas	tous).	
	

G 	 Se	Rappeler	que	pour	les	hits	la	localisation	correspond	à	l'endroit	où	la	balle	s'arrête/retombe	après	la	
frappe.	 Voir	 le	 diagramme	 du	 terrain	 pour	 définir	 la	 localisation	 du	 hit	 sur	 la	 page	 61.	
	

☺	 Vous	pouvez	utiliser	le	numéro	de	position	(1-9)	ou	l'abréviation	(p,	3b,	lf..).	
	 S'assurer	que	la	notation	est	la	même	sur	la	feuille	de	scorage	
	

1B		8	/	1B	CF	 simple	au	champ	centre	
1B		5	BU	 simple	sur	un	amortie	en	troisième	base	
2B		7	/	2B	LF	 double	au	champ	gauche	
3B		9	/	3B	RF	 triple	au	champ	droit	
HR		8	/	HR	CF	 homerun	au-delà	du	champ	centre	
HR	RF	IP	 homerun	inside	the	park	au	champ	droit	
2B	9	GR	 double		automatique	lié	à	une	règle	de	terrain		
1B	LC	 simple	entre	champ	gauche	et	centre	
1B	RC	 simple	entre	champ	droit	et	centre	
1B	LL	 simple	le	long	de	la	ligne	de	champ	gauche	
1B	RL	 simple	le	long	de	la	ligne	de	champ	droit	
1B	LS	 simple	du	côté	gauche	de	l'infield	
1B	RS	 simple	du	côté	droit	de	l’infield	
1B	MI	 simple	au	milieu	de	l’infield	
	

But	sur	balles,	hit	by	pitch	
BB	 but	sur	balles	
IBB	 but	sur	balles	intentionnel	
HP	/	HBP	 hit	by	pitch	
	

Retrait	suite	à	une	frappe	au	sol	
63	 relais	de	l'arrêt-court	au	1ère	base	(grounded	out	63)	
163	 roulant	sur	le	lanceur	>	arrêt-court>	1ère	base	
3U	/	3UA		 roulant	vers	le	1ère	base	sans	assistance	(unassisted)	
31		BU	 roulant	sur	un	amorti,	relais	1ère	base	>	lanceur		
		 (grounded	out	on	a	bunt)	
	
Fly	Out	
F8	 fly	au	champ	centre	
P6	 pop	fly	à	l'arrêt-court	(POP	FLY:	high	fly	ball	to	infield,	in	fair	territory).	
L5	 flèche	sur	le	3ème	base	
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FF5	 fly	en	territoire	des	fausses	balles	sur	le	3ème	(foul	fly	5)	
IF6	 infield	fly	sur	l'arrêt-court	
	

Strike	outs	
KS	 strike	out	swingé	
KL	 strike	out	appelé	(looking	=	no	swing)	
KS	23	 3ème	strike	relâché	et	retrait	en	1ère	base	
KS		WP	 3ème	strike	relâché	sur	un	lancer	fou,	frappeur	atteint	la	1ère	base	
	
KS		PB	 3ème	strike	relâché	sur	une	balle	passée,	frappeur	atteint	la	1ère	base	
KS		E2T	 3ème	strike	relâché	et	arrivée	en	1ère	base	sur	une	erreur	de	receveur	
KS		E3M		A2	 3ème	strike	relâché	et	arrivée	en	1ère	base	sur	une	erreur	d'attrapé	après	
		 assistance	du	receveur	
	
K	avec	un	jeu	sur	les	coureurs:	
	
KS		FC			//	coureur:	25		CS	 3ème	strike	relâché	et	arrive	en	1ère	base	sur	un	choix	défensif,		
		 			caught	stealing	25	pour	le	coureur	
KS		24		DP	//	coureur:	X		CS	 3ème	strike	relâché	et	caught	stealing	24;	double	jeu	pour	le	2	et	le	4	
	

Erreurs	
	
E6F	 erreur	d'attrapé	
E4T	 erreur	de	relais	
E6D	 erreur	d'attrapé	d'un	fly	par	l'arrêt-court	
E6F		+E	 le	même	frappeur	arrive	en	2ème	base	sur	cette	erreur	
E4M		A6	 pour	un	jeu	6E4	(erreur	d'attrapé	du	relais	par	le	2ème	base)	
E3	DF		 erreur	d'attrapé	d'un	fly	en	territoire	des	foul	ball	
E3F	BU	 erreur	d'attrapé	sur	un	amorti		
E1T	FPO	 erreur	sur	un	pick-off,	coureur	sauf	en	1ère	base		
	

!	Le	programme	ne	distingue	pas	les	erreurs	décisives	et	non	décisives.	
	
☺	 Se	 Rappeler	 que	 la	 syntaxe	 de	 certains	 jeux	 défensifs	 est	 “L'INVERSE	 ”	 DE	 L'ORDRE	 UTILISÉ	 POUR	 LE	
SCORAGE,	ex.:	1E3	au	scorage	est	E3M	A1	avec	le	programme).	
	

 Choix	défensif	
	
FC	6	 choix	défensif	(O6	or	FC),	la	balle	a	été	frappée	sur	l'arrêt-court.		

Toujours	indiquer	la	position	du	défenseur	sur	lequel	la	balle	a	été	frappée.			
FC	3	BU	//	coureur	16	 choix	défensif	sur	un	amorti	vers	le	1ère	base,	coureur	retiré	en	2ème	base	
	 16	
	
Avance	sur	un	relais:	
	
+T	 symbole	pour	le	frappeur	ou	le	coureur,	par	exemple	après	un	hit:	1B	8	+T	
++T	 le	coureur	avance	de	deux	bases	sur	le	relais.		
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O/2,	O/#	:	Indifférence	défensive	du	receveur	/	…	
	
FC	 	 écrire	FC	pour	le	coureur	(mais	avant:	ouvrir	la	fenêtre	“Comments”,	et		
		 	 écrire	“Defensive	Indifference”).		
	

GDP	(Grounded	into	Double/triple	Play)		

463		GDP	//coureur:	X	 GDP	46	>	63:	le	programme	crédite	automatiquement	les	assistances,		
		 les	retraits	et	le	DP	aux	joueurs	défensifs.		
		 Écrire	seulement	X	pour	le	coureur	retiré.	
543		TP		//coureurs:	X			X	 en	 cas	 de	 triple	 jeu,	 	 écrire	 X	 pour	 les	 deux	 coureurs		
	 dans	ce	cas:	jeu	5	–	54	–	43		
FC		54		GDP	//coureurs:	X			X	 GDP	avec	une	balle	occupée	(FC).	Dans	ce	cas:	jeu	5	>	54	>	GDP	O5.	
	
DP	/	TP	défensive	(pas	de	GDP):	
	
KS		24		DP		//coureur:	X		CS	 double	jeu	sur	strike	out		et	caught	stealing		
L6		DP			//coureur:	X	 double	jeu	au	l'arrêt-court	et	coureur	retiré		
L54	DP		//coureur:	X	 double	jeu	line	out	du	3ème,	assistance	3b	>	2b.		
543	TP			//coureurs:	X		X	 triple	jeu	line	out	du	3ème,	assistance	3b	>	2b.	Assistance	2b	>	1b.		
F862		DP			//coureurs:	X			 	 double	jeu	fly	out	du	champ	centre,	assistance	8	>	6	>	2	
F862	TP	//	coureurs:	X	X	 triple	jeu	fly	out	du	champ	centre,	assistance	8	>	6,	assistance	6	>	2	
FC	X	//	coureur	654	DP	 double	 jeu;	 frappeur	 arrivé	 en	 1ère	 base	 et	 après	 est	 retiré	
		 assistance	6	>		5,	assistance	5	>	4	
I6	//	coureur:	X	 double	jeu	de	l'arrêt-court	sur	infield	fly,	qui	touche	ensuite	un	coureur	dans	
	 une	situation	de	double-jeu	avec	un	infiled	fly,	utiliser	seulement	I	pas	IF.		
	

Sacrifices:		
	
13		SAC	//	coureur(s):		+	 Sacrifice	Hit	13	pour	le	frappeur.	Avance	du	(des)	coureur(s).	
E3M		A1		SAC		//	coureur(s):		+	 Sacrifice	Hit	1E3	pour	le	frappeur.	Avance	du	(des)	coureur(s).	
E3F		SAC			//	coureur(s):		+	 Sacrifice	Hit	E3.	Avance	du	(des)	coureur(s).	
F9		SF			//		coureur(s):		+	 Sacrifice	Fly	9.	Avance	du	(des)	coureur(s).	
E8D	SF	//	coureur(s)	+	 Sacrifice	Fly	8	erreur	d'attrapé.	Avance	du	(des)	coureur(s).	
	

RBI	
	
Dans	beaucoup	de	situations,	 le	programme	reconnaît	qu'il	y	a	un	RBI.	Dans	ce	cas,	 il	demande	confirmation:	
“Insert	the	number	of	RBI	(0-1-2-3)”.	L'OS	indique	le	chiffre	exact.		
	
Avance	du	(des)	coureur(s)	et	du	frappeur	
	
Pour	accorder	les	avances	du	(des)	coureur(s),	 il	 faut	placer	 le	curseur	dans	le	cadre	grisé	correspondant	en	
utilisant	ENTER.		
	
+	 avance	d'une	base	
++	 avance	de	deux	(2)	bases	
+++	 avance	de	trois	(3)	bases	
	
C	Si	un	coureur	N'	avance	PAS:	>	appuyer	sur	ENTER	dans	le	cadre	grisé.	
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+		+E	 si	le	coureur	avance	sur	la	frappe	et	ensuite	sur	l'erreur.	
	
Remarquez	cette	différence:	
++E	 le	coureur	avance	de	deux	bases	sur	l'erreur	
	
1B	6	+E6T	 si	le	frappeur	avance	d'une	base	supplémentaire	grâce	à	une	erreur		
		 décisive	ou	non.	Dans	l'exemple:	simple	sur	l'arrêt-court	et	erreur	de		
		 relais	de	l'arrêt-court:	le	frappeur	atteint	la	2ème	base.			
	
G	Si	plusieurs	avances	ont	lieu	sur	une	même	erreur,	NE	PAS	ECRIRE	le	numéro	de	position	du	joueur	
plusieurs	fois,	parce	que	sinon	on	lui	accorde	2	erreurs,	mais	écrire	les	autres	avances	avec	+E.		
	
1B		8		+E8T			//	coureurs:	+		+E			 Dans	l'exemple:	Coureur	en	1ère	base.	Simple	au	champ	centre	et	erreur		
	 non	 décisive	 sur	 le	 relais	 du	 champ	 centre:	 le	 batteur	 atteint	 la	 2ème	 base.	
	 Le	coureur	atteint	la	2ême	base	sur	la	frappe	et	la	3ême	sur	l'erreur.	
	
F9	SF	//coureurs:	+E9T	//	+E	//	+	 pour	indiquer	que	le	coureur	avance	en	raison	de	l'erreur	faite	sur	le	jeu		
		 ou	sur	un	autre	coureur.	Dans	l'exemple:	Bases	pleines.	SF	au	champ		
	 droit.	Le	coureur	en	3ème	base	marque.	Ensuite,	erreur	de	relais	du		
	 champ	droit.	Les	autres	coureurs	avancent	en	3ème	et	2ème	base	sur	l'erreur.	
Pour	le	batteur:	F9	SF	//	pour	le	coureur	en	1ère	base:	+E9T	//	pour	le	coureur	en	2ème	base:	+E	//	pour	le	coureur	
qui	marque:	+	
	
G	 S'il	 y	 a	 déjà	 2	 retraits	 et	 que	 le(s)	 coureur(s)	 avance(nt)	 à	 cause	 d'une	 erreur,	 se	 rappeler	 D'ECRIRE	
L'AVANCE	+E,	pour	indiquer	que	l'avance	n'est	pas	au	débit	du	lanceur	(pour	le	compte	des	points	mérités).			
	

Vol	de	base	(Stolen	Base)	–	Caught	Stealing	
	
SB	 vol	de	base	pour	le	coureur.	(Inutile	de	le	créditer	au	receveur)	
FPO	 échec	d'une	tentative	de	pick	off	(Failed	Pick	Off	attempt)	
SB	E2T	 vol	de	base	suivi	d'une	avance	sur	une	erreur		
SB	FPO	 vol	 de	 base	 après	 échec	 d'une	 tentative	 de	 pick	 off	 (SB	 non	 crédité	 au	
	 receveur).		
24	CS	 Caught	Stealing,	assistance	du	receveur,	retrait	du	2b.		
E6M	CS	FPO	–	A13	 Caught	Stealing	13E6		
		 Erreur	décisive	de	l'arrêt-court,	après	tentative	de	pick	off,	
	 Assistances	du	lanceur	et	du	1ère	base.		
		 Si	le	cadre	grisé	n’est	pas	assez	long	:	saisir	le	jeu,	puis	retourner	sur	le	
	 coureur	et	ajouter	les	assistances.		
136	CS	PO	 Caught	Stealing	après	un	pick	off	–	jeu	136	
13	PO	 retiré	sur	pick	off	–	jeu	13	
	
WP,	PB,	BK	
	
Pour	indiquer	ce	type	d'avances,	placer	le	curseur	dans	le	cadre	grisé	correspondant	en	utilisant	ENTER.		
	
WP	 lancer	fou	(Wild	Pitch)	
PB	 balle	passée	(Passed	Ball)	
BK	 Balk	
	
C	Si	plusieurs	coureurs	avancent	sur	le	même	WP/PB/BK:		
>	Écrire	le	symbole	pour	chaque	coureur	
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++WP		 Si	un	coureur	avance	de	2	bases	sur	la	même	action.		
	 (Ne	pas	écrire	WP	2	fois	car	le	programme	en	compterait	2)	
KS		WP	 Strike	out	swingé	relâché	et	Wild	Pitch	
KS		PB	 Strike	out	swingé	relâché	et	Passed	Ball	
	

Points	mérités	(ER)	/	Points	non	mérités	(Not	Earned	Runs)	
	
Tout	d'abord,	remarquer	que	le	programme	les	affiche	avec	des	symboles	différents	sur	la	feuille	de	scorage	qui	
apparait	sur	l'écran:		
ER:		ª					 Not	ER:		o		
	
Lorsqu'il	n'y	a	pas	de	question	sur	 le	point,	 le	programme	reconnaît	automatiquement	un	point	mérité.	Dans	
tous	les	cas	où	le	programme	n'est	pas	sûr,	il	demandera	d'indiquer	si	le	point	est	mérité	ou	non.			
Exemple:				“Is	Mazzanti	G’s	Run	an	Earned	Run?						Y)es			N)o		T)eam	unearned”	
	
Ensuite,	appuyer	sur	la	touche:			
Y	 (Yes)	 –	N	 (No)	 –	 T	 (si	 le	 point	 n'est	 pas	mérité	 pour	 l'équipe	 (Team)	 =	 ER	 pour	 le	 lanceur,	mais	 pas	 pour	
l'équipe).	
☺	Parfois	le	scoreur	doit	attendre	pour	savoir	si	un	point	est	mérité	ou	non	en	fonction	des	actions	suivantes.	
Lorsque	le	point	devient	mérité,	utiliser	le	Play	Editor	(?page	35)	pour	modifier.	
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Out	By	Rule	
	
BI	 Batteur	retiré	pour	interférence	
RLE	 Départ	anticipé	(Runner	Left	Early)		
	
AUCUN	autre	symbole	d'OBR	n'est	individualisé.		

	
Lorsqu'il	y	a	un	OBR,	ouvrir	d'abord	la	fenêtre	de	commentaire	dans	le	menu	scoresheet	("Comment")	ajouter	le	
commentaire,	revenir	dans	la	fenêtre	de	jeu	et	saisir	le	jeu	sur	le	frappeur	et/ou	le	coureur.	
	
:::	NOM		-	Batter’s	illegal	action	:::	 Pour	le	batteur:	2U	
:::	NOM		-	Strikeout	by	rule	:::	 Pour	le	batteur:	KS	or	KL	
:::	NOM		-	Touched	by	own	batted	ball	:::	 Pour	le	batteur:	2U	
:::	NOM		-	Out	of	turn	:::	 Pour	le	batteur:	2U	(ou	le	jeu)	
:::	NOM		-	Refuse	to	touch	first	base	:::	 Pour	le	batteur:	2U	
:::	NOM		-	Runner	refuses	to	advance	to	home	plate	:::	 Pour	le	batteur:	2U	
:::	NOM		-	Dropped	infield	fly	:::	 entrer	le	jeu	
:::	NOM		-	Hit	by	fair	ball	:::	 entrer	le	jeu	(batteur	coup	sûr,	coureur	le	jeu)	
:::	NOM		-	Base	line	violation	:::	 entrer	le	jeu	
:::	NOM		-	Passing	preceding	runner	:::	 entrer	le	jeu	
:::	NOM		-	Run	reverse	order	:::	 entrer	le	jeu	
:::	NOM		-	Runner	interference	:::	 entrer	le	jeu	
:::	NOM		-	Interference	by	preceding	runner	:::	 entrer	le	jeu	
	

Perturbation	de	l'ordre	de	frappe	(Batting	Out	of	Turn):		
	
B:#									 pour	indiquer	le	numéro	du	frappeur	irrégulier	(dans	l'ordre	de	frappe)		
B:4	 le	4ème	batteur	vient	à	la	place	de	3ème	

	

Tie	Breaker	
	
R:#,b							 pour	remplacer	et	indiquer	le	numéro	du	frappeur	sur	la	bonne	base	
R:3,2		 pour	placer	le	3ème	batteur	en	2ème		base		
	
Quand	un	Tie	Break	débute	avec	un	nouveau	lanceur,	être	attentif	à	bien	saisir	le	nouveau	lanceur	avant	de	
placer	les	coureurs/	batteur	dans	cette	nouvelle	manche.		
	

Arrêt	de	jeu	
	
Chaque	visite	au	lanceur	doit	être	indiquée	afin	qu'elle	apparaisse	dans	le	Play	by	Play.	Procéder	comme	suit:		
	
>	Aller	dans	SCORESHEET	Menu	>	COMMENTS		
>	Écrire	:::Coaching	visit	to	mound:::	
	

Pour	activer	les	commentaires	dans	le	play-by-play,	appuyer	sur	F4.	Quand	on	n'appuie	pas	sur		F4,	le	
commentaire	n'apparaît	qu'après	le	jeu	suivant.		
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Autres	jeux	
La	plupart	des	jeux	possibles	ont	maintenant	été	vus	et	décrits.	Pour	toutes	les	autres	situations,	se	reporter	à	la	
liste	qui	s’affiche	avec	la	commande	F1.	
	

Autres	commentaires	
	
Outre	les	exemples	donnés	pour	les	commentaires,	il	est	aussi	possible	d'écrire	:		
	
:::	Suspended	Game	-	Injury	Delay	:::	
:::	Suspended	Game	-	Rain	Delay	:::	
:::	Suspended	Game	-	Fog	Delay	:::	
:::	Suspended	Game	-	Light	Failure	:::	
:::	Game	should	be	restarted	at	hh:mm	:::	
	
Ne	jamais	rien	écrire	à	propos	de	l'expulsion	d'un	joueur!!!	
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Raccourcis	clavier	
	
Certaines	combinaisons	de	touches	permettent	d'accéder	plus	facilement	à	certains	menus:		
	
ALT	+	F1	 Afficher	la	liste	des	raccourcis	clavier.	Pour	sortir,	appuyer	sur	ESC.	
	
F1	 Afficher	la	liste	exhaustive	des	symboles		
	 (pour	avancer	et	reculer	dans	la	fenêtre,	utiliser	les	touches	"page	haut"	et	"page	bas"		
		 du	clavier	de	votre	ordinateur)	
	
ALT	+	B		 Afficher	le	"contrôle"	(balance)	de	la	feuille	de	scorage	
ALT	+D	 Afficher	les	positions	défensives	
ALT	+E	 Edit	plays	
ALT	+F	 Sauvegarder	le	fichier	de	la	rencontre	
	 (après	avoir	rempli	le	Game	Info	et	à	la	fin	de	la	rencontre).	
		 (Pendant	la	rencontre,	le	programme	le	fait	automatiquement	à	la	fin	de	chaque	demi-
	 manche).		
ALT	+	G	 Afficher/modifier	le	Game	Info		
ALT	+	H	 Masquer	(Hide)	le	menu	
ALT	+	I	 Lire	les	Informations	du	Play	by	play.		
		 (Utiliser	les	touches	↑↓	pour	vous	diriger)	
ALT	+L	 Afficher/modifier	les	line	ups	
CTRL	+	L		 Liste	des	changements	
ALT	+	Q	 Quitter	un	menu	
ALT	+R	 Afficher/modifier	les	rosters	
ALT	+S	 Afficher	les	statistiques	d'un	équipe	(offensive	et	pitching).		
		 Très	utile	pour	vérifier	les	données	avec	le	scoreur	officiel	
ALT	+T	 Tourner	la	page,	passer	d'une	feuille	de	scorage	à	l'autre.	
ALT	+	U	 Mise	à	jour	(Update)	des	comptes	de	stats	
ALT	+W	 Wrap-up	(clore)	de	la	rencontre	(à	faire	à	la	fin	de	la	rencontre).	
	
Pour	les	changements:		
	
F5	 Modifier	le	line	up	défensif	

F6	 Noter	un	changement	de	lanceur	

F7	 Noter	un	Pinch	Hitter	

F8	 Modifier	le	line	up	offensif	/	noter	un	pinch	runner	
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Modification	d'une	rencontre	et	insertions	
	

Lorsque	vous	avez	besoin	d'ouvrir	une	rencontre	pour	la	vérifier,	la	modifier	ou	pour	reprendre	le	scorage	en	cas	
de	rencontre	suspendue:		
			
>	Aller	dans	Main	Menu,	et	sélectionner	File		

	
	

	

	

	

	

	

	

	

	

	

	

	

>	Sélectionner	Load	Game	
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>	Sélectionner	une	des	équipes	(TEAMS)	qui	a	joué	la	rencontre	(peu	importe	laquelle),	en	
utilisant	les	flèches	du	clavier	(↑↓)	(Dans	l'exemple	Belgium)	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
>	Taper	ENTER	et	la	liste	de	toutes	les	rencontres	de	cette	équipe	apparaît.			
>	Sélectionner	la	rencontre	dans	la	liste	proposée,	en	utilisant	des	flèches	du	clavier	(↑↓)	
>	Taper	ENTER	pour	accepter	
	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
La	rencontre	à	revoir,	vérifier	ou	modifier	est	maintenant	ouverte	à	l'écran	et	vous	pouvez	la	poursuivre	en	
utilisant	Plays.	Ne	pas	oublier	de	refaire	le	wrap-up	après	avoir	terminé.		
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Résolution	des	problèmes	
	

a)	Problèmes	avec	la	connexion	Internet		
	
Normalement,	si	toutes	les	connexions	sont	correctes	et	câbles	intacts,	il	vous	faudra	contacter	le	responsable	du	
site.		
	
Une	connexion	câblée	est	plus	sûre	et	rapide	qu'une	connexion	sans	fil	(wi-fi).		
	
Si	le	problème	persiste,	continuer	le	scorage	de	la	rencontre	et	à	la	fin	de	la	rencontre	réaliser	les	manipulations	
de	la	troisième	partie	(Après	la	rencontre)	avec	un	autre	ordinateur	ou	depuis	un	autre	endroit.	
	
☺ Quelques	fois,	s'il	y	a	un	problème	avec	la	connexion	Internet		sur	le	terrain	(le	play	by	play	n'est	plus	mis	à	jour	
automatiquement),	il	vous	faudra	réactiver	le	programme.		
	
Dans	ce	cas,	aller	dans	la	fenêtre	Game	Reports	–	Live	–	Live	Setup,	décocher	la	case	ACTIVATE,	et	cocher	la	de	
nouveau.	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

PANNE	SÉVÈRE	DE	LA	CONNEXION	INTERNET		

	
G Si	après	avoir	fait	tout	ce	qui	est	indiqué	au-dessus,	la	connexion	ne	fonctionne	toujours	pas	
correctement,	il	faut	prendre	le	temps	de	tout	vérifier	et	procéder	ainsi	:		

	
>	Sauvegarder	la	rencontre		
>	Quitter	la	rencontre		
>	Trouver	l'icône	TAS	FTP														qui	se	trouve	sur	le	bureau	dans	la	barre	de	tâche	en	bas			

	
>	Sélectionner	et	choisir,	Fin	de	tâche,	en	appuyant	en	même	temps	sur		CTRL	+	ALT	+	SUPPR	
>	Cliquer	sur	TERMINER	MAINTENANT		
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>	Sortir	de	SCCP	>	Sortir	du	programme	
>	Entrer	à	nouveau	dans	le	programme	>	Charger	la	rencontre	(File	>	Load	Game)	
>	Aller	dans	LIVE	>	LIVE	SETUP	
>	Cocher	à	nouveau	la	case	ACTIVATE	
Si	tout	ceci	ne	marche	pas,	essayer	ceci	:		
>	GAME	REPORTS	>	sélectionner	la	rencontre	>	LIVE	>	SEND	STAT	FILES	
	
a) joueurs	n’apparaissant	PAS	dans	le	roster	:		

	
Lorsqu’il	y	a	un	nouveau	joueur	dans	le	line	up	donné	par	une	équipe,	ou	qu’un	joueur	n’apparaît	

pas	dans	le	roster	(liste	jaune	à	droite),	informer	le	Commissaire	Technique	de	la	rencontre.	

	
b) Erreur	‘BS	Game’	
	
Si	un	direct	est	commencé	sans	avoir	sélectionné	une	rencontre,	un	message	d'erreur	de	BS	Game	
s'affiche.	

	
Fermer	la	fenêtre,	charger	la	rencontre	et	essayer	de	nouveau.			
	
c) TeamViewer	
	

Parfois,	il	est	plus	facile	pour	l'OC	de	prendre	la	main	sur	votre	ordinateur	
plutôt	que	de	discuter	du	problème	via	Skype.	Pour	cela,	on	peut	utiliser	le	logiciel	
TeamViewer.	Vérifier	avec	l'OC	que	TeamViewer	est	installé	et	qu'un	raccourci	est	
présent	sur	le	bureau	de	l'OS.			

	
Lorsque	l'OC	souhaite	utiliser	TeamViewer,	double	cliquer	sur	l'icône	et	envoyer	les	identifiant/mot	de	
passe	via	Skype	à	l'OC.			
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 Check-list	des	tâches	à	effectuer	
 
AVANT	LA	RENCONTRE	
	
1)	Se	connecter	à	Internet	
2)	Mettre	à	jour	les	dossiers	stats	/	rosters	/	résultats	…		 page		 9		
	 -	télécharger	ou	importer	le	dossier	de	l'opérateur	central	
	 -	copier-coller	le	dossier	sur	votre	ordinateur	
	 -	mettre	à	jour	les	stats		
3)	Capturer	les	stats	des	équipes	 page	 12	 	
4)	Remplir	le	Game	Info	(ville,	stade,	l'heure,	les	arbitres…)		 page	 14	
5)	Sélectionner	les	équipes	et	rentrer	les	line	ups	 page		 16	
6)	Sauvegarder	la	rencontre	 page	 18	
7)	Charger	les	stats	des	équipes		 page		 20	
8)	Insérer	le	nom	des	scoreurs	et	des	commissaires	techniques	(TC)		 page	 22	
10)	Activer	la	rencontre	“live”	sur	Internet		 page	 24	
	 -	Insérer	les	logos	des	équipes	
	 -	charger	les	stats	des	équipes	
		 -	"activer"	la	rencontre	
11)	Indiquer	que	la	rencontre	est	en	direct	sur	le	site	web		 page	 27	
	

	
PENDANT	LA	RENCONTRE	
	
En	plus	de	scorage:	
	

* Vérifier	les	stats	avec	le	scoreur	officiel		
* Insérer	un	commentaire	en	cas	de	visite	au	lanceur	

	
page	

	
33	

*	Insérer	les	changements	de	position	 page	 38	

	
APRES	LA	RENCONTRE	

  

1)	Faire	le	"Wrap	up"	(pitchers’	credits,	etc.)	 page	 41	
2) Vérifier	les	stats	avec	le	scoreur	
3) Générer	les	fichiers	html	de	la	rencontre	

	
page	

	
42	

4)	Mettre	en	ligne	la	box	score	sur	le	site	web	 page	 43	
5)	Mettre	à	jour	le	résultat	de	la	rencontre	sur	le	site	web	de	la	compétition	 page	 44	
6)	Exporter	la	rencontre	et	envoyer	les	fichiers		sur	le	serveur	 page	 45	
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La	"field	map"	–	Localisation	des	coups	sûrs	
 

 
 
 
 
 


